Video Management System Pro

User Manual

Milesight Technology Co., Ltd.
Copyright Statement

This manual may not be reproduced in any form or by any means to create any derivative such as translation, transformation, or adaptation without the prior written permission of Milesight Technology Co., Ltd (Hereinafter referred to as Milesight).

Milesight reserves the right to change this manual and the specifications without prior notice. The latest specifications and user documentation for all Milesight products are available on our official website www.milesight.com.
Content

Chapter I Introduction ............................................................................................................. 1
  1.1 Milesight VMS Pro Introduction ................................................................................. 1
  1.2 Key Features ............................................................................................................... 1
Chapter II Installation ............................................................................................................ 2
  2.1 Software Overview .................................................................................................... 2
  2.2 System Operating Environment .............................................................................. 2
  2.3 Installation Guide ...................................................................................................... 2
Chapter III Operations and Settings .................................................................................. 6
  3.1 How to Execute Milesight VMS Pro ............................................................ ............ 6
  3.2 Configuration ............................................................................................................ 7
  3.3 Settings ....................................................................................................................... 22
  3.4 File ............................................................................................................................ 24
  3.5 Tools .......................................................................................................................... 25
  3.6 Help ............................................................................................................................ 26
  3.7 Toolbar ....................................................................................................................... 27
Chapter IV Live view .......................................................................................................... 28
  4.1 Camera Tree Window ............................................................................................... 29
  4.2 Live Toolbar ............................................................................................................. 31
  4.3 Live View Workspace ............................................................................................... 31
  4.4 PTZ control ............................................................................................................... 32
  4.5 Image Configuration ................................................................................................. 34
Chapter V Playback ............................................................................................................. 35
Chapter VI Map .................................................................................................................. 39
  6.1 Toolbar ....................................................................................................................... 40
  6.2 Pop-Up Menu ............................................................................................................ 41
  6.3 Add the Hot ............................................................................................................... 41
Chapter VII Milesight VMS Server .................................................................................... 42
Chapter VIII Service .......................................................................................................... 43
Chapter I Introduction

1.1 Milesight VMS Pro Introduction

Milesight VMS Pro (Video Management System) is one of the most innovative and most powerful video management software systems on the market and it will fulfill your highest requirements and expectations. The simple and intuitive design requires little training while providing easy access to live and recorded video, facility maps and alarms. The user who has the authority can configure all server and cameras settings from a central location. Utilize the left panel navigation tree structure to navigate the server and cameras as well as to access features like searching out the online server and cameras automatically, checking the information of the server and camera. Use Client/Server architecture, it is a future-proof network video solution for large projects and can manage unlimited network cameras via unlimited working servers in different locations. It’s able to integrate with other cameras over ONVIF.

This manual describes how to use and manage “Milesight VMS Pro” in your network environment. Some knowledge of network environment would be beneficial to the readers. Should you require any technical assistance, please contact authorized service center.

1.2 Key Features

✧ Support 1/ 2/4/ 6/8/ 9/ 13/ 16/ 20/24/30/36/49/ 64 channels playing synchronously
✧ H.265/H.264/MPEG-4 /MJPEG video compression
✧ Client/Server architecture, support to add multiple-server
✧ Record locally or to network storage
✧ Customizable user access levels
✧ E-mail notification
✧ Support dual-stream
✧ 4-CH synchronized playback and up to 16-CH asynchronous playback
✧ Alarm or scheduled recording
✧ Integrated Motion-Detection from camera
✧ Multiple monitors support
✧ Human-oriented Milesight UI
✧ Support ONVIF
Chapter II Installation

2.1 Software Overview

An installation of “Milesight VMS Pro” has two components: Server software and Client software.
“Milesight VMS Server” is the intelligence management system forward the RTSP stream, and the Client software is used to log in the server and provides the user interface for all tasks including monitoring, searching, reporting and configuration. “Milesight VMS Client” allows users in different locations to log into the server. If users have the right, they are able to change the system configuration.

2.2 System Operating Environment

CPU: 2.4GHZ or faster
Memory: 2G MB or more
Graphic memory: 1G or more
Internet protocol: TCP/IP

2.3 Installation Guide

Run the Milesight VMS Pro installation file and install the programs on your computer by following the on-screen instructions. After finishing installation, you will find the programs on the start menu or on the desktop.

Step1: Select the preferred language for this installation.

Figure 2.1
Step 2: Click “Next” to go on.

Step 3: Read the information to know about Milesight VMS Pro and accept it, then go on.

Step 4: Here you need to install “Milesight VMS Client” and “Milesight VMS Server” to complete the installation.
Step 5: Choose the destination.
**Step 6:** Finish the installation.

![Figure 2.6](image-url)

Figure 2.6
Chapter III Operations and Settings

3.1 How to Execute Milesight VMS Pro

(1) Start “Milesight VMS Server” first
Double click the icon to start the server after installation, then all the cameras on the server will load automatically.

(2) Then, start “Milesight VMS Client”
Double click the icon to start the software after starting the Milesight VMS Server.
When you log in “Milesight VMS Client”, a window will pop up as below. Enter the Username, Password. The default user name and password is “admin” and “password”. You can also choose which language to be used for the Client. If the [Auto Login] is selected, “Milesight VMS Client” will log in without keying in the Username and Password next time.

![Image](image1)

Figure 3.1

After you click on the “Login” button, the window will pop up as follow. Please wait for a few seconds. After loading the cameras successfully, “Milesight VMS Client” will come into view.

![Image](image2)

Figure 3.2

After login into the system, you can see the Live View page as below:
3.2 Configuration

Before using “Milesight VMS Client” for live view, you need to add the server first. Then you are able to add the cameras via different servers. Only after adding the server and cameras, can you use functions like live view, playback, E-map etc.

How to Add Server?
There are two ways to add servers via “Milesight VMS Client”: one way is searching online automatically, the other is adding manually. After adding successfully, you can see the name
of the server under “Default Group”. Right-click the “Default Group” and select “Server Management” option, the window will pop up as follow. Click on the “Search Server” button to search servers automatically, while click on the “Add Server” button to add manually. Details will be shown in the following figures.

Figure 3.5

- **Search Server**
  Click the button, the window will show as below. You can search servers automatically.

Figure 3.6
You can also click the “Server Online” in the Settings to search the online Server as below:

![Image of server online](image)

**Figure 3.7**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop/Rescan</td>
<td>When searching the servers, you can stop it and rescan by clicking again.</td>
</tr>
<tr>
<td>Select All</td>
<td>All the servers will be selected at a time.</td>
</tr>
<tr>
<td>Clear All</td>
<td>All the servers will be unchecked at a time.</td>
</tr>
<tr>
<td>Set Password</td>
<td>Enter the password at a time.</td>
</tr>
<tr>
<td>OK</td>
<td>Click [OK] button to confirm the settings.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Exit quit.</td>
</tr>
</tbody>
</table>

**Add Server**

When the button is clicked, the window will show as below. You can add the server manually.

![Image of add server](image)

**Figure 3.8**
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Type</td>
<td>Choose the VMS Server you use</td>
</tr>
<tr>
<td>Name</td>
<td>The name of server.</td>
</tr>
<tr>
<td>Port</td>
<td>The port of the server.</td>
</tr>
<tr>
<td>User Name</td>
<td>The user name of the server.</td>
</tr>
<tr>
<td>IP</td>
<td>IP address of the server.</td>
</tr>
<tr>
<td>SQL port</td>
<td>SQL port.</td>
</tr>
<tr>
<td>Password</td>
<td>Password of the server.</td>
</tr>
<tr>
<td>Enable</td>
<td>Enable or unable the server.</td>
</tr>
</tbody>
</table>

**Edit Server**

When the button is clicked, the window will show as below. Edit the information of the camera.

![Server Information Window](image)

**Delete Server**

Remove the server from “Milesight VMS Client”.

**Configure Server**

Here you can do the settings for the server. Including General Settings, Camera Management, Schedule Settings, Motion Detection, Network Settings, User Management, Log Management and Record File Management.

For more details, please refer to the below content “How to Add IP Camera”.

www.milesight.com
How to Add Network Camera?

After adding the server successfully, you need to configure the server further, including searching cameras, adding them to the live view window, setting motion detection, setting recording schedule, etc. Adding, modifying, removing and SMTP for Server could be also set here. The details are as below.

When you click on the “Config” button, window pops up as below, including General Settings, Camera Management, Schedule Settings, Motion Detection, Network Settings, User Management, and Log Management.
3.2.1 Camera Management

Click “Camera Management” button, the pop-up window is as below.
# Search Camera

![Search Camera Window](image)

**Figure 3.14**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop/Rescan</td>
<td>When searching the cameras, you can stop it and rescan by clicking again.</td>
</tr>
<tr>
<td>Select All</td>
<td>All the cameras will be selected at a time.</td>
</tr>
<tr>
<td>Clear All</td>
<td>All the cameras will be unchecked at a time.</td>
</tr>
<tr>
<td>Set Password</td>
<td>Enter the password at a time.</td>
</tr>
<tr>
<td>OK</td>
<td>Click [OK] button to confirm the settings.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Exit quit.</td>
</tr>
</tbody>
</table>

*Note:* Before you register Milesight VMS Pro, you can only add up to 4 cameras. For more information, please refer to Chapter VII Milesight VMS Server.

# Add Camera

When the button is clicked, the window will show as below. You can add the camera manually.

Through IP address you can add Milesight’s cameras and other cameras supporting ONVIF.

Through RTSP stream you can add cameras supporting RTSP.

*Note:* Those options with * are required, including Name, IP, Port, User Name, Password.
Edit Camera

When the button is clicked, the window will show as below. Edit the information of the camera.

Click on “Video Settings” button, you can change the video parameters here.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Stream</td>
<td>Choose the main stream or 2nd stream to play.</td>
</tr>
<tr>
<td>Video Codec</td>
<td>Including H.265, H.264, MJPEG.</td>
</tr>
<tr>
<td>Frame Size</td>
<td>The resolution.</td>
</tr>
</tbody>
</table>
Maximum Frame Rate: Maximum refresh rate of frames
Bit Rate: Transmit bits of data per second

![Image of Video Setting]

Figure 3.17

- **Delete Camera**
  Remove the camera from “Milesight CMS Client“.

- **Browsing Web.**
  Browse the web of the camera.

- **Modify IP address.**
  Modify the IP address.

### 3.2.2 General Settings

Click “General” button, the window will pop-up as below. Here you can set the Recording Path (support multiple disks at the same time), Server Name and Server Port. It’s also able to decide how long to schedule recording time length, to keep the recorded files and event/alarm log. At the same time, you can decide whether to delete these files automatically or not and when. It also supports to set file expired time 120 days at most. The Server will automatically delete files when the file expired.

And you also can decide whether to make the server auto login to windows. The “auto login to windows” option in Server general settings. If you enable this option and input the account for Server’s computer, then it can auto log in Windows and run up VMS Server after
Windows Started.

Figure 3.18

Click the **Network Storage** button the window will pop-up as below, you can add the NAS to storage the recording.

Figure 3.19

### 3.2.3 Schedule

Set the time schedule. When the button is clicked, the window will show as below. Here you can choose the schedule to be an auto recording schedule or an alarm schedule.
Step 1: Click “Add” button to add a new schedule as a time template. You can draw the timeline for each day. Here you can choose the schedule to be an auto recording schedule or an alarm schedule. Make sure the [Enable] button is checked.

The schedule settings include:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The schedule name.</td>
</tr>
<tr>
<td>Enable</td>
<td>Enable or disable the schedule.</td>
</tr>
<tr>
<td>Date from/Date to</td>
<td>Begin or stop to put in the schedule.</td>
</tr>
<tr>
<td>Record Mode</td>
<td>Including alarm and continuous record</td>
</tr>
<tr>
<td>Trigger</td>
<td>Motion Detection from “Milesight VMS Client”, Network Camera or</td>
</tr>
</tbody>
</table>

Figure 3.20

Figure 3.21
Motion+I/O itself.

**Capture Image**
Capture how many pictures per second when alarm is triggered.

**Pre record**
Setting length of the pre-alarm recording file. Setting range: 0-9s.

**Post record**
Setting length of the post-alarm recording file. Setting range: 1-1800s.

**Email**
Enable to use the SMTP.

**Step2**: Choose a type under the “Record Type”.

- **Note**: If you choose the “Alarm” type as the record type, you can also do some settings including “Trigger Condition”, “Action When Alarm is Triggered”.

If you choose the “Alarm” type as the record type, the timeline is red. While if you choose the “Record” type as the record type, the timeline is blue.

---

**Figure 3.22**

If you choose the “Alarm” type as the record type, the timeline is red. While if you choose the “Record” type as the record type, the timeline is blue.
Figure 3.23

Note: Left-click to draw the timeline and right-click to cancel again.

Step 3: Select the cameras on the left camera list and move them to the right camera list.

Step 4: Click [OK] to confirm the settings.

3.2.4 Motion Detection

Do the alarm settings here. When the button is clicked, the window will show as below. Draw the areas where to be detected.

Step 1: Select the camera on the left tree which you want to set motion detection. Make sure the “Enable” button is checked. Draw certain areas by left-click mouse.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select All</td>
<td>Select all of the area to be detected</td>
</tr>
<tr>
<td>Clear All</td>
<td>Clear all of the area</td>
</tr>
<tr>
<td>Level</td>
<td>Different levels to trigger alarm</td>
</tr>
<tr>
<td>Detection Interval</td>
<td>How often to trigger alarm</td>
</tr>
</tbody>
</table>

Step 2: Select the cameras on the left camera list and move them to the right camera list.

Step 3: Click [Apply] to confirm the settings.

3.2.5 Network

Here you can do the settings for SMTP. Click on the “Network” button and the window will
pop up as below.

![Image of network settings](image)

**Figure 3.25**

**SMTP:** Enter the SMTP server, port, SMTP sender, password and the SMTP receiver, then when the alarm is triggered, the server will send you an email to inform you what happened. Now we can support three kinds of encryption types (NO_SECURITY, USE_SSL, USE_TLS). If you are not sure, contact with the connection provider or the network administrator. If you want to send a test email, click “Test”.

**DDNS:** Choose different types of provider, enter the Host name, User name and Password. The DDNS can translate constant hostnames into changing IP addresses. This is used to provide a persistent domain name for a resource that may change location on the network.

### 3.2.6 User Management

Users are managed in the User Management dialog box.

Users can be created, modified, and deleted from the User Management dialog box in “Milesight VMS Client”. Several properties of a user including User Name and Password can be changed here. When the button is clicked, it shows as Figure3.25.

- **Note:** Different users have different permissions to access the server.

- **User Type:**
  - Administrator: Full access to do any settings.
  - Operator: Do anything except create a new operator user.
  - Viewer: Can’t change any settings but to view.
When the “Add” button is clicked, the window will show as below.

![Figure 3.26](image)

3.2.7 Log Management

When the button is clicked, the window will show as below. You can change the different log under the option, including “Event Log” and “Alarm Log”.

![Figure 3.27](image)
3.3 Settings

- Local Settings
This part is mainly used for local settings. Select a disk to store the recorded files and images. You can also set how long to keep the operation logs and alarm logs here. (Mainly used in the local recording and snapshot)

- **Note**: The default disk is the destination disk where you install “Milesight VMS Pro”.
When you click the “Settings->Local Settings” button, the window will show as below.

![Figure 3.29](image-url)
- **Better Image Quality**
  Better image quality uses YUV (traditional is RGB) display mode, which can make the whole effect of video image more clear.

- **Carousel Settings**
  Choose an interval between each other. After being set, the cameras in the live view mode will alternates with different cameras at a time within an interval.

- **Connect Network Camera Stream Directly**
  Decrease the load of the server when connecting Network Camera stream directly and the server needn’t to forward the video stream.

  ❖ **Note:** We do not recommend that you check this opinion on when several servers connecting with the same Network Camera at the same time.

- **Show Stream Information**
  This option supports to show stream information, including video codec, resolution, frame rate and bit rate as below. The user can change the setting in Local Setting.

![Figure 3.30](image-url)
Alarm Audio
Play audio when alarm is triggered. The Live View page will appear the alarm icon. You can select the audio to play as below, when you select the “Customize”, you can upload the audio that you want to. Currently only wav format is supported.

```
Enable AlarmAudio: [Unable] [Customize] [AlarmAudio1] [AlarmAudio2]
```

Alarm action
Enable alarm pop up: Check on this option. If a camera is not on the live view channel, it also will pop up when alarm is triggered.
Windows always on top when alarm: Check on this option. If “Milesight VMS Pro” program was minimized, it’ll restore to the original size when alarm is triggered.

Change Password
Here you can change the password of “Milesight VMS Client”.

3.4 File

File->Lock
When you click the [Lock] button, the GPI page will be locked. Then click it again, the window will show as below.

![Figure 3.33](image)

You have to key in Username and Password to unlock it.

- **File->Exit**
  Username and Password are required when logging out “Milesight VMS Client”. And if the [Auto Login] is checked, “Milesight VMS Client” will log in without keying in the Username and Password next time.

![Figure 3.34](image)

### 3.5 Tools

- **Tool-> Multi Monitor**
  Now “Milesight VMS Client” support multiple monitors. When click on the “Multi Monitor” button, the window pops up as follow. “Milesight VMS Client” supports to use up to 4 monitors now. There are 3 modes you can choose to use in each monitor, including Live
Screen mode, Fullscreen mode and Alarm Screen mode. What you need to do is to drag the cameras to the position of the monitor you want to show.

**Live screen mode**: For this mode, you can add any cameras which you want to show on the screen. Just drag the cameras and move it into the specified monitor.

**Fullscreen mode**: Click on the main console monitor, double click on the individual position of the camera, then the live video will be showed in full screen on the specified monitor.

**Alarm screen mode**: When the camera is triggered, the live video will play on the monitor. (Now this mode only supports to display 16 channels at the same time)

![Multi-Monitor](Image)

**Figure 3.35**

**Tools->Log Management**
Please refer to 3.2.7

**Tools-> Change Language**
Select the language for “Milesight VMS Client”. Milesight VMS Client currently supports 8 languages: English, Simplified Chinese, Traditional Chinese, Korean, Italian, Portuguese, Russian and Japanese.

**3.6 Help**

**Help-> Online Help**
Here you can feedback any questions to Milesight and seek any help from Milesight.
Help-> About Milesight VMS Pro

“Milesight VMS Client” information can be checked here.

Figure 3.36

3.7 Toolbar

Add short cut icons on toolbar as below.

Figure 3.37

<table>
<thead>
<tr>
<th>Num</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Lock/Unlock</td>
<td>Lock/Unlock “Milesight VMS Client”. For details, please refer to 3.3 File.</td>
</tr>
<tr>
<td>2</td>
<td>Display/ Play toolbar</td>
<td>Display or hide toolbar.</td>
</tr>
<tr>
<td>3</td>
<td>Fullscreen</td>
<td>You can view the live video in full screen mode. To return to the normal screen, press [Esc] button on the keyboard.</td>
</tr>
<tr>
<td>4</td>
<td>Live view modes</td>
<td>Support 1/2/4/6/8/9/13/16/20/24/30/36/49/64 channels playing synchronously.</td>
</tr>
<tr>
<td>5</td>
<td>Synchronous Playback</td>
<td>In the playback mode, choose to playback 4 cameras synchronously.</td>
</tr>
<tr>
<td>6</td>
<td>Previous Page</td>
<td>Switch to the previous group cameras when in carousel mode.</td>
</tr>
<tr>
<td>7</td>
<td>Next Page</td>
<td>Switch to the next group cameras when in carousel mode.</td>
</tr>
<tr>
<td>8</td>
<td>Start/Stop Carousel</td>
<td>Start or stop the carousel mode.</td>
</tr>
<tr>
<td>9</td>
<td>Save view</td>
<td>Save the Live View pattern.</td>
</tr>
</tbody>
</table>
Chapter IV Live view

“Milesight VMS Client” software provides the user interface for all tasks including monitoring, searching, reporting and configuration. The interface is shown as below.

![Figure 4.1](image)

This part is mainly used for real-time video preview and polling mode setting. The first time “Milesight VMS Client” is started, you should add some cameras to it. You can add the cameras manually or by searching cameras. For details, please refer to 3.2.1 Camera Settings-> Add Camera and 3.2.1 Camera Settings-> Search Camera. After adding the camera, you have to drag it to the live view window to display the video.

How to Connect the Camera

**Step1:** Select a camera in window 1.

**Step2:** Double-click on the camera or drag and drop the camera to the individual position. The camera is connected automatically and live video will show in the selected window.

**Step3:** Repeat step1 to 2 to connect other cameras. You also can drag and drop the server to the live view window to batch add all the cameras which inside the server to the individual position.

**Note:** Please make sure the camera is available 📹.
How to Disconnect the Camera

**Step1:** Select a camera in window 1.

**Step2:** Right click the camera. Select [Enable], the camera will be disconnected. If you want to connect again, click it again.

**Step3:** Repeat step 1 to 2 to disconnect other cameras.

4.1 Camera Tree Window

This part is to display the added camera. There are 3 types shown bellow.

Right-click on the view list, Pop-up Menu:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New View</td>
<td>Create a new view to save the camera</td>
</tr>
<tr>
<td>View Management</td>
<td>Manage all the saved view</td>
</tr>
</tbody>
</table>

Right-click on the group, Pop-up Menu:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Management</td>
<td>Manage the server</td>
</tr>
<tr>
<td>Server Online</td>
<td>Search out the online-server</td>
</tr>
<tr>
<td>Play All</td>
<td>Play all the live videos</td>
</tr>
<tr>
<td>Stop All</td>
<td>Stop all the live videos</td>
</tr>
</tbody>
</table>
Note: The status of server like below means the server is out of connection.

![Figure 4.4]

Right-click on the server, Pop-up Menu:

![Figure 4.5]

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Config Server</td>
<td>Configure the server</td>
</tr>
<tr>
<td>Search Camera</td>
<td>Search out the online-cameras</td>
</tr>
<tr>
<td>Server Information</td>
<td>Server information</td>
</tr>
<tr>
<td>Enable</td>
<td>Enable/Disable the server</td>
</tr>
<tr>
<td>Enable All</td>
<td>Enable all the cameras under the server</td>
</tr>
<tr>
<td>Unable All</td>
<td>Disable all the cameras under the server</td>
</tr>
<tr>
<td>Play All</td>
<td>Play all the live videos</td>
</tr>
<tr>
<td>Stop All</td>
<td>Stop all the live videos</td>
</tr>
</tbody>
</table>

Right-click on the camera, Pop-up Menu:

![Figure 4.6]
### Item Description

**Camera Information**
- Please refer to 3.2.2 Camera Settings-> Edit Camera

**Browsing Web**
- Please refer to 3.2.2 Camera Settings-> Browsing Web

**Enable**
- Connect or Disconnect the camera

**Play**
- Start the live video

**Stop**
- Stop showing all the videos

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td>available</td>
<td>✔️</td>
<td>unusable</td>
</tr>
<tr>
<td>🔴</td>
<td>failed to connect</td>
<td>🔴</td>
<td>alarm status</td>
</tr>
</tbody>
</table>

**Note:** When the camera is failed to connect successfully for the first time, it will try to reconnect at an increasing intervals until it succeed. If it is failed to connect for a long time, drag it into the live view screen to play again. You can also click the camera and unable it, and then enable it again, it will connect successfully again.

### 4.2 Live Toolbar

![Figure 4.7](image)

**Icon** | **Item**       | **Description**                                                                                                                                 |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td><strong>Record</strong></td>
<td>Record manually. And this icon will turn into <a href="image">Record icon</a>.</td>
</tr>
<tr>
<td>🔊</td>
<td><strong>Audio</strong></td>
<td>Play Audio or stop it. (Audio is unusable in the polling live view window)</td>
</tr>
<tr>
<td>📸</td>
<td><strong>Snapshot</strong></td>
<td>Take a snapshot when viewing.</td>
</tr>
<tr>
<td>📣</td>
<td><strong>Display</strong></td>
<td>Display.</td>
</tr>
<tr>
<td>✗️</td>
<td><strong>Stop Display</strong></td>
<td>Stop showing the videos.</td>
</tr>
<tr>
<td>🔍</td>
<td><strong>Zoom In</strong></td>
<td>Enable to zoom in a specific area of video image with mouse wheel.</td>
</tr>
<tr>
<td>🔌</td>
<td><strong>Fullscreen</strong></td>
<td>You can view the live window in full screen mode. To return to the normal screen, press [Esc] button on the keyboard.</td>
</tr>
<tr>
<td>🔴</td>
<td><strong>Talk</strong></td>
<td>Talk with the people who beside the Network Camera.</td>
</tr>
<tr>
<td>🔴</td>
<td><strong>Open/Ground</strong></td>
<td>Manual Alarm, if it’s status is different from Network Camera’s External Output setting it will trigger alarm.</td>
</tr>
</tbody>
</table>

### 4.3 Live View Workspace

This part is used for displaying the live view. Right click the mouse, and the window will show as follow.
4.4 PTZ control

This part is for the flexibility of remote pan/tilt/zoom through operator control. It is possible to zoom in on small distant objects with exceptional clarity. The user can easily track objects with high precision by using a mouse or joystick.
Figure 4.9

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Navigation Key" /></td>
<td>Navigation key is used to control the direction. The rotation key is used for auto-rotation.</td>
</tr>
<tr>
<td><img src="image2" alt="Rotation Key" /></td>
<td>To adjust the speed of pan/tilt movements, from 1 to 10</td>
</tr>
<tr>
<td><img src="image3" alt="Zoom In/Out" /></td>
<td>Click -/+ to zoom in and zoom out</td>
</tr>
<tr>
<td><img src="image4" alt="Focus" /></td>
<td>Click to focus near or far of the lens</td>
</tr>
<tr>
<td><img src="image5" alt="Iris Adjustment" /></td>
<td>Iris adjustment</td>
</tr>
<tr>
<td><img src="image6" alt="LED" /></td>
<td>Click to open/ close the White LED for lighting 30s</td>
</tr>
<tr>
<td><img src="image7" alt="Auto Focus" /></td>
<td>Auto Focus</td>
</tr>
</tbody>
</table>
When click the button it pop-up the Patrol edit window as below:

![Image Configuration](image)

### 4.5 Image Configuration

This part is used to Image Settings. The window as below:

![Image Configuration](image)
Chapter V Playback

In this part, you can search and play back the recorded files of a selected IP camera. When you click the [Playback] button, the window will show as below.

![Playback Window](image)

Figure 5.1

How to Replay the Recorded Files

**Way1:** Asynchronous Playback

**Step1:** Select which camera to replay on the left, and then check it.

**Step2:** Select a date and the file type you want to search. The File Type includes: All / Motion Detection/ Timing.

**Step3:** Click 🎥 button.

**Step4:** Choose a playback mode, if it’s asynchronous playback, 1/2/4/6/9/13/16 panes modes are able to use.

❗ **Note:** Synchronous playback only supports for 4 panes mode.

**Step5:** Click the file on the list and it will begin to play the recorded files.

### Play toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎥</td>
<td>Play</td>
<td>Play the video.</td>
</tr>
<tr>
<td>🎥</td>
<td>Pause</td>
<td>Pause the video.</td>
</tr>
<tr>
<td>🎥</td>
<td>Stop</td>
<td>Stop the video.</td>
</tr>
</tbody>
</table>
**Operative Skills**

Timelines will help you find the correct videos when there are too many files on the list. It's easy to zoom out the area by scrolling the mouse wheel to find exactly the incident you are looking for.

Take a file near 10:00 for example, when the position of mouse is between 08:00 and 10:00, then scroll up the mouse wheel, the position of this file will show as follow. Scroll down to turn back.

You can hold down the left mouse and drag the mouse to left or to right (between the intervals from 00:00 to 24:00) to get the exact recorded files.

**Begin:**

![Figure 5.2](image)

**Scroll up 1:**

![Figure 5.3](image)

**Scroll up 2:**

![Figure 5.4](image)

**Scroll up 3:**
**Way2: Synchronous Playback**

**Step1:** Click on the [Sync play] button.

**Step2:** Select the camera to replay on the left, and then check it.

**Step3:** Select a date and the file type you want to search. The File Type includes: All / Motion Detection/ Timing.

**Step4:** Click button.

**Step5:** Click the file on the list and it will begin to play the recorded files.

- **Note:** Synchronous playback only supports for 4 panes mode. If you want to change the camera to view, just right click on the window, choose the “Remove” option, and drag the different camera to the window.
How to Export the Recorded Files

Here is for exporting the recorded files from “Milesight VMS Client”.

Over “Milesight VMS Client”, you can export the recorded files to your local PC. Choose the start time and the stop time for the recorded files, then select the file type, including Alarm Type and Schedule Type. Then choose a destination where save the files on your local PC. Right-click on the file list, select the “Export” option to export the recorded files.

How to Import the Recorded Files

Here is for importing the files which were exported to the local PC before to “Milesight VMS Client”.

Over “Milesight VMS Client”, you can import the exported files in your local PC to “Milesight
VMS Client”. Click Local File and choose Import, find the destination of the exported files, choose what you want to import, then select the “Confirm” option to import the recorded files.

![Image](image.png)

Figure 5.9

Chapter VI Map

In this part, you can add an electronic map and different cameras to the map. The display of map graphics in the Map window can be controlled. The size of the map can be selected, and the map can be moved in the window to show the area you want to view. Use the zoom in / zoom out buttons or with the mouse wheel to adjust the map size. Right-click on the map and choose the “Lock” option, this would prevent the accidental deletion of the map.

It is easy to navigate between different layers of maps, and to show the maps of cameras in various locations. Here you can add different maps for each server.

Note: Only on the layers of the server, can you drag the cameras to the server map. When you click the [Map] button, the window will show as below.
6.1 Toolbar

Modify When the [Add Map] button is clicked, the window will show as below. Different image formats such as bmp / gif / png / jpg are supported.

![Edit Map Window](image)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🗿️</td>
<td>Delete Map</td>
<td>Remove the map from “Milesight VMS Client”.</td>
</tr>
<tr>
<td>🔍</td>
<td>Zoom In</td>
<td>Enlarge the picture to see more details.</td>
</tr>
<tr>
<td>🔍🔍</td>
<td>Zoom Out</td>
<td>Zoom out the map.</td>
</tr>
<tr>
<td>🔍</td>
<td>Reset</td>
<td>Return the map to its original size.</td>
</tr>
<tr>
<td>🚫</td>
<td>Delete Hot</td>
<td>Remove the camera from the map.</td>
</tr>
</tbody>
</table>
6.2 Pop-Up Menu

Right-click the map (anywhere except the cameras). A menu will pop up as figure 6.3.

![Lock and Unlock menu](image)

### Figure 6.3

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock</td>
<td>If the map is locked, you can do nothing with the map but zoom in or zoom out.</td>
</tr>
<tr>
<td>Unlock</td>
<td>You can do anything if the map is unlocked.</td>
</tr>
</tbody>
</table>

Right-click the camera. A menu will pop up as figure 6.4.

![Play and Delete menu](image)

### Figure 6.4

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Remove the camera from the map.</td>
</tr>
<tr>
<td>Play</td>
<td>Live preview.</td>
</tr>
</tbody>
</table>

6.3 Add the Hot

Click the camera and drag it to the E-map, then it will be added successfully. After the camera has been added on the E-map, you can double click on the hot to play.

![Camera on E-map](image)

### Figure 6.5
Chapter VII Milesight VMS Server

An installation of “Milesight VMS Pro” has two components: server software and client software.

The Server functions as the intelligence management system forward the RTSP stream. After you log on “Milesight VMS Server”, an icon will appear like this. Right-Click on the icon, the window is shown as below.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop/Start</td>
<td>Stop/Start running “Milesight VMS Server”.</td>
</tr>
<tr>
<td>Change Language</td>
<td>Change the server language.</td>
</tr>
<tr>
<td>Help</td>
<td>Feedback any questions to Milesight.</td>
</tr>
<tr>
<td>Online Help</td>
<td></td>
</tr>
<tr>
<td>About Us</td>
<td>About the version information of “Milesight VMS Server”.</td>
</tr>
<tr>
<td>Run When Startup</td>
<td>Run the program when computer startup.</td>
</tr>
<tr>
<td>Register now</td>
<td>Activate “Milesight VMS Pro”.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exit “Milesight VMS Server”.</td>
</tr>
</tbody>
</table>

Note: Before activating “Milesight VMS Pro”, you can add up to 4 cameras. If you want to use more cameras, please contact with Milesight to activate “Milesight VMS Pro” via “Milesight VMS Server”.

www.milesight.com
Chapter VIII Service

Milesight Technology Co., Ltd provides customers with timely and comprehensive technical support services. End-users can contact your local dealer to obtain technical support. Distributors and resellers can contact directly with Milesight for technical support. Technical Support Mailbox: support@milesight.com

Web: http://www.milesight.com
Online Problem Submission System: http://www.milesight.com/service/feedback.asp
Address: Room 202, No.23 Wanghai Road, 2nd Software Park, Xiamen, China
Zip Code: 361006
TEL: +86-592-5922772
FAX: +86-592-5922775